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Introduction

You can use LibreOffice without requiring a pointing device, such as a mouse or trackball, by
using the keyboard shortcuts that are available in Impress. Tasks as varied and complex as

docking and un-docking toolbars and windows, or changing the size or position of objects can all
be accomplished with using keyboard shortcuts. Although LibreOffice has an extensive set of
keyboard shortcuts, each LibreOffice module has keyboard shortcuts that are specific to that

module.

For help with LibreOffice keyboard shortcuts, or using LibreOffice with a keyboard only, search
the LibreOffice Help using the “shortcut” or “accessibility” keywords.

In addition to using keyboard shortcuts, that are listed in this appendix, you can also define your
own keyboard shortcuts. You can assign keyboard shortcuts to standard Impress functions or
your own macros and save them for use with Impress only, or with the other modules in
LibreOffice. To customize keyboard shortcuts to your requirements, see the Getting Started
Guide for more information.

Impress keyboard shortcuts

Note

Some keyboard shortcuts are not available for computers using macOS. This is
indicated in the following tables by a blank cell.

Impress functions

Windows

c macOS Effect

Linux
Switches to text edit mode and opens the Text

F2 F2 .
Formatting toolbar.

F3 F3 Enter and edit a group of objects.

Ctrl + F3 ¥} +F3 Exit a group of objects.

Shift + F3 Shift + F3 Opens the Duplicate dialog of a selected object.

E4 F4 Opens the Position and Size dialog of a selected
object.

Alt + Shift + E5 Alt + Shift + E5 O_pens Notes view and displays the first slide in the
slide show.

Ctrl + Shift+F5 3 + Shift + F5 Opens the Navigator.
Forward navigation of the emphasis within the on

F6 F6 ; :
screen elements without using mouse.

Shift + F6 Shift + 6 Backward navigation of the .empha5|s within the on
screen elements without using mouse.

F7 F7 Start spelling checker.

Shift + F7 Shift + F7 Switches on or off the automatic spell checking.
Opens the Thesaurus dialog for the language being

Ctrl + F7 *+F7 used. Impress has to be in text editing mode to access

the thesaurus.
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Windows

. macOS Effect
Linux
F8 F8 When selected, opens the Edit Points toolbar.
Ctrl + Shift + F8 3 + Shift + F8 Fit text to frame of a selected object.
Shift + F10 Shift + F10 Opens the context menu of a selected object.
F11 B+T Open the Styles deck on the Sidebar.
Switches on or off the Impress edit mode. When
Ctrl + Shift + M 3 + Shift + M switched off, a slide show is displayed in read only
mode.
Slide shows
Windows
Linux Effect
macOS
F5 Starts a slide show.
Shift + E5 <i[arts a slide show at the slide where the slide show was previously stopped
Esc Minus (-) Stop and close the slide show.
Spacebar
Enter
N If available, plays the next animation effect on a slide.
Down arrow Shows the next slide
Right arrow
Page Down
Backspace
Z If available, plays the previous animation effect on a slide.
p arrow . ;
L Shows the previous slide
eft arrow
Page Up
Alt + Page Down Go to next slide without playing any animation effects.
Al + Go to the previous slide without playing any animation effects
g\rlsgzber] then Type the number of a slide and press Enter to show the slide.
Home Jump to first slide in the slide show.
End Jump to the last slide in the slide show.
B Show black screen until next key or mouse wheel event.
. (period)
w Show white screen until next key or mouse wheel event.
, (comma)
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Impress shortcuts

Windows

. macOS Effect
Linux
Plus (+) Zoom in.
Minus (-) Zoom out.
Times (%) on . . , .
number pad Fits the slide to fill the Workspace view.
Divide (=) on Zooms in on the selected object.
number pad
Ctrl + Shift + G 3 + Shift+ G Group selected objects.
Shift + Ctrl + Alt + | 38 + Shift + Unaroub selected arou
G Option + G group group-
. . Enter a group to edit individual objects in the group.
Ctrl + click 3 + click Click outside the group to return to normal view.
Ctrl + Shift + G 3 + Shift+ G Combine selected objects.
Ctrl + Shift + Alt + | 3 + Shift + Split a selected object that has been combined from a
K Option + K group of two or more objects.
Ctrl + + 3 ++ Bring to front.
Ctrl +Shift + + 3 + Shift + + Bring forward.
Ctrl + - 3 +- Send backward.
Ctrl + Shift + - 38 + Shift + - Send to back.
Moves a selected object in the direction of the arrow.
Arrow Arrow Also moves a slide within the Workspace when no
objects are selected.
Shift + Click and Shift + Click and Hold down Shift then click and drag when resizing an
drag drag object to maintain the proportions of the object.
Shift + Click and Shift + Click and Constrains movement of a selected object horizontally
drag drag or vertically when dragged.
Ctrl + Click and 3 + Click and Hold down the Ctrl (38) key, then click and drag a
drag drag selected object to create a copy of the object.
Alt + Click and Option + Click Hold down the Alt (Option) key and draw or resize an
drag and drag object from the centre of the object.

Alt + Click

Option + Click

Select an object that is behind the currently selected
object.

Alt+ Shift + Click

Option + Shift +
Click

Select an object that is in front of the currently selected
object.

Selects several adjacent objects or characters. Click at

Shift + Click Shift + Click the start of a selection, move to the end of the
selection, and then hold down Shift while you click.

Tab Tab Select objects in the order in which they were created.

Shift + Tab Shift + Tab Select objects in the reverse order in which they were

created.
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Windows

. macOS Effect
Linux
Esc Esc Exit current mode.
Switch to the previous slide. No function on the first
Page Up :
slide.
Page Down Switch to the next slide. No function on the last slide.
Enter Enter Actlva_lte a place—h_older object in a new presentation
(only if the frame is selected).
AutoLayouts in Impress use placeholders for slide titles,
text, and objects.
To select a placeholder, press Ctrl + Enter (38 + Enter).
Ctrl + Enter 38 + Enter To move to the next placeholder, press Ctrl + Enter (38
+ Enter) again.
If you press Ctrl + Enter (38 + Enter) after you reach the
last placeholder in a slide, a new slide is inserted after
the current slide using the same layout.
Editing text
M{mdows macOS Effect
Linux
Inserts a custom hyphen in text at the cursor position.
Ctrl + - #H+- Also known as a soft hyphen.
Ctrl + Shift + - S8 + Shift + - Inse.'r'ts a non-breaking hyphen in text at the cursor
position. Also known as a hard hyphen.
. . Non-breaking spaces. Non-breaking spaces are not
Ctrl + Shift + % + Shift + used for hyphenation and are not expanded if the text is
Space Space Co
justified.
Shift + Enter Shift + Enter Line break without paragraph change.
Left arrow Left arrow Moves the cursor one character to the left.

Shift + Left arrow

Shift + Left arrow

Moves the cursor one character to the left and selects
the character.

Ctrl + Left arrow

Option + Left
arrow

Moves the cursor to the beginning of the previous word.

Ctrl + Shift + Left Option + Shift + Moves the cursor to the left and selects the word on the
arrow Left arrow left.

Right arrow Right arrow Moves the cursor one character to the right.

Shift + Right Shift + Right Moves the cursor one character to the right and selects
arrow arrow the character.

Ctrl + Right arrow

Option + Right
arrow

Moves the cursor to the beginning of the next word.

Ctrl + Shift + Option + Shift + Moves the cursor to the right and selects the word on
Right arrow Right arrow the right.
Up arrow Up arrow Moves the cursor up one line.
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Windows
Linux

macOS

Effect

Shift + Up arrow

Shift + Up arrow

Moves the cursor up one line in the text and selects the
lines of text.

Ctrl + Up arrow

Option + Up
arrow

Moves the cursor to the beginning of the paragraph.

Ctrl + Shift + Up

Option + Shift +

Moves the cursor to the beginning of the paragraph.
Selects the text in the paragraph from the cursor

arrow Up arrow position to the beginning of the paragraph.

Down arrow Down arrow Moves the cursor down one line.

Shift + Down Shift + Down Moves the cursor down one line in the text and selects

arrow arrow the lines of text.

g:rtrr(l):VDown & + Down arrow Moves the cursor to the end of the paragraph.

Ctrl + Shift + Opt + Shift + Moves the cursor to the end of the paragraph._ Selects
the text in the paragraph from the cursor position to the

Down arrow Down arrow
end of the paragraph.

Home Moves the cursor to the beginning of the line.

Shift + Home Moves the cursor to the beginning qf the line and
selects the text from the cursor position.

Ctrl + Home Move§ the cursor to the beginning of the text block on
the slide.

End Moves the cursor to the end of the line.

Shift + End Moves the cursor to the_e_nd of the line and selects the
text from the cursor position.

Ctrl + End M'oves the cursor to the end of the text block on the
slide.

Ctrl + Del Delete the text from the cursor position to the end of the
word.

Ctrl + Shift + Del Delete the text from the cursor position to the end of the

sentence.

Ctrl + Backspace

& + Backspace

Delete the text from the cursor position to the beginning
of the word.

Ctrl + Shift +
Backspace

3 + Shift +
Backspace

Delete the text from the cursor position to the beginning
of the sentence.

Menu keyboard shortcuts

The keyboard shortcuts listed in the following tables are available in each menu category on the
Menu bar. The tables give the menu item or sub-item, operating system validity, and the effect or
purpose of the shortcut.
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Note

The menus listed below are in the same order as displayed on the Menu bar from left

to right.
File menu
Menu item or Windows
sub-item Linux LEIEO Effect
Opens the Open file browser so you can
Open Ctrl + O ¥+0 navigate to a folder and select a
document.
Save Ctrl+ S ¥+S Saves the open document.
Opens the Save as file browser so you
Save As Ctrl + Shift + S ¥ +Shift+S can save the open document as a new
document.
Opens the Print dialog so that you can
Print Ctrl + P ¥ +P select how you want to print the
document.
Edit Menu
Mem_l item or Vl{mdows macOS Effect
sub-item Linux
Undo Ctrl+Z ¥} +Z Undoes the previous editing action.
Redo Cirl+Y £ +Yy Reverses the action of the last Undo
command.
Cut Ctrl + X 8 + X Deletes t_he selected object and places it
on the clipboard.
Copy Ctrl + C €+ C Cpp|es the selected object to the
clipboard.
Paste Cirl + V 88 +V Places the object on the clipboard into
the document.
Paste Special >
Paste Ctrl + Shift + Alt | 38 + Shift + Paste copied text at the cursor position
Unformatted +V Option + V without any formatting.
Text
Pastes the contents of the clipboard at
Paste Special > , . the cursor position in a format that you
Paste Special Ctrl + Shift +V 3 + Shift +V can specify using the Paste Special
dialog.
Select All Ctrl+ A #F+A Selects all objects on a slide.
Opens the Edit Points toolbar if there is
Points F8 F8 an object on the slide that uses editable

points, for example a freeform line.
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Mem_l item or I/I{mdows macOS Effect
sub-item Linux
Switches on or off the Impress edit
Edit Mode Ctrl + Shift + M ¥ + Shift+ M mode. When switched off, a slide show
is displayed in read only mode.
View menu
Menu item or Windows
sub-item Linux IO Effect
Rulers Ctrl + Shift + R 38 + Shift + R Switches the rulers off and on in the
Workspace.
Sidebar Ctrl + F5 #& +F5 Opens or closes the Sidebar.
Styles F11 %+ T O_pens or closes the Styles deck on the
Sidebar.
Navigator Ctrl + Shift+F5 ¥ + Shift + F5 Opens the Navigator.
Insert menu
Menu item or Windows
sub-item Linux B0 Effect
Switches to text edit mode and opens
Text Box F2 F2 the Text Formatting toolbar.
Hyperlink Ctrl + K ¥ +K Opens the Hyperlink dialog.
Comment Ctrl + Alt + C % + Option + C Inserts a new comment box onto the
selected slide.
Formatting
Mark > Insert Ctrl + Shift + ¥ + Shift + Inserts a non-breaking space at the
non-breaking Space Space cursor position.
space
Formatting
Mark > Insert .
Narrow Ctrl + Shift+F5 S8 + Shift + F5 Inserts a narrow no-breaking space at
the cursor position.
No-break
Space
Formatting
Mark > Inserts a narrow no-width no optional
No-width Curl+/ 3% +/ break at the cursor position.
Optional Break
Format menu
Mem! item or Vl{lndows macOS Effect
sub-item Linux
Text > Bold Ctrl + B ¥ +B Applies Bold format to selected text.
Text > Italic Ctrl + | ¥+ Applies ltalic format to selected text.
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Mem_l item or VI{lndows macOS Effect
sub-item Linux
Text > _ Ctrl + Shift + P % + Option + C Applies superscript format to selected
Superscript text.
Text > . . . .
S . Ctrl + Shift + B 38 + Shift + B Applies subscript format to selected text.
ubscript
;?Z)(é > Increase Ctrl +] ¥ +] Increases the point size of selected text.
Text > _ Ctrl + [ % +[ Decreases the point size of selected
Decrease Size text.
Spac!ng > Line Ctrl + 1 8 +1 S_ets thfe line spacing in a paragraph to a
Spacing 1 single line.
Spac!ng Line Ctrl +5 £ +5 Sets the line spacing in a paragraph to
Spacing 5 one and half lines.
Spac!ng > Line Ctrl + 2 58 + 2 Sets_the line spacing in a paragraph to
Spacing 2 two lines.
Align > Left Ctrl + L 8 + L Sgts the paragraph alignment to left
aligned.
Align > Center Ctrl+ E % +E Sgts the paragraph alignment to center
aligned.
Align > Right Ctrl+ R 8 + R Sgts the paragraph alignment to right
aligned.
Align > Justified | Ctrl +J 5 +J _Sets_the paragraph alignment to
justified.
. Shift + Alt + Demotes a point to the next level when
Lists > Demote . - .
Right arrow Outline view.
. Shift + Alt + Promotes a point to the next level when
Lists > Promote . - !
Left arrow in Outline view.
Lists > Move Shift + Alt + Shift + Option + | Moves a point down the order when in
Down Down arrow Down arrow Outline view.
Lists > Move Shift + Alt + Up Shift + Option + | Moves a point up the order when in
Up arrow Up arrow Outline view.
Styles > Opens or closes the Styles deck on the
Manage Styles F11 #+T Sidebar.
Object and
Shape > Opens the Position and Size dialog of a
e F4 F4 .
Position and selected object.
Size
Arrange > Bring Ctrl + Shift + + S8 + Shift + + Moves a_selected object to the front of
to Front other objects.
Arrange > Bring Crl + + 8 + + Moves a sglected object in front of the
Forward forward object.
Arrange > Send Ctrl + - 8 + - Moves a selected object behind the

Backward

backward object.
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Menu item or

Windows

sub-item Linux b i
Arrange > Send |~ L cpin o S8 + Shift + - Moves a selected object to the back of
to Back other objects.
Group > Group Ctrl + Shift + G ¥ + Shift+ G Group selected objects.
Group > Ctrl + Alt + Shift | 3+ Option +
Ungroup + G Shift + G Ungroup selected group.
group > Enter F3 F3 Enter and edit a group of objects.
roup
Group > Exit : .
Group Ctrl + F3 ¥ +F3 Exit a group of objects.
Slide menu
Menu item or Windows
sub-item Linux macos St
New Slide Ctrl+ M Ctrl+ M Inserts a new slide into the slide show.
Jump to Last . Option + Shift + | Opens the last slide edited in the
Edited Slide Alt + Shift + F5 F5 document.
Move > Slide to Ctrl + Shift + Moves the selected slide to the
Start Home beginning of the slide show.
Move > Slide Ctrl + Shift + % + Shift + Up | Moves the selected slide above the
previous slide. No function on the first
Up Up Arrow :
slide.
Move > Slide Ctrl + Shift + ¥ + Shift + Moves the selected slide below the next
Down Down Down Arrow slide. No function on the last slide.
Move > Slide to Ctrl + Shift + Moves the selected slide to the end of
End End the slide show.
Navigate > To page U Switch to the previous slide. No function
Previous Slide ge &p on the first slide.
Navigate > To Page Down Switch to the next slide. No function on
Next Slide 9 the last slide.
Slide Show menu
Menq item or I/I{lndows macOS Effect
sub-item Linux
gf%ré from First F5 F5 Starts a slide show from the first slide.
Start from Starts a slide show at the slide where
Shift + F5 Shift + F5 the slide show was previously stopped

Current Slide

at.
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Tools menu

Mem_l item or Vl{mdows macOS Effect

sub-item Linux

Spelling F7 F7 Start spelling checker.

Autom_atlc Spell Shift + E7 Shift + E7 SWltches on or off the automatic spell

Checking checking.
Opens the Thesaurus dialog for the
language being used. Impress has to be

Thesaurus Ctrl + F7 #® +F7 in text editing mode to access the
thesaurus.

Extension Ctrl+Alt+ E ¥d} +AIt+E Opens the Extension Manager dialog.

Manager

Options Alt+ F12 Opens the Options LibreOffice dialog.

Windows menu

Menu item or Windows

sub-item Linux LEIEO Effect

Closes Window | Ctrl + W 8 + W Close_s the active Wln_dow. If there is only
one window, LibreOffice Impress closes.

Help menu

Mem_l item or M{mdows macOS Effect

sub-item Linux

LibreOffice = = Opens your browser application at the

Help LibreOffice Help pages.

Toolbar keyboard shortcuts

Impress provides several toolbars to help you to create slides and slide shows. Some of the tools
on these Impress toolbars can be activated by using a keyboard shortcut.

Note

The toolbars are listed in the same order that is displayed in the context menu that
opens when you click on View > Toolbars on the Menu bar.

Drawing
Windows
Tool name Linux Effect
macOS
Insert Text Box E2 Switches to text edit mode and opens the Text Formatting

toolbar.
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Windows

Tool name Linux Effect
macOS
giCJZsE:tlon and F4 Opens the Position and Size dialog of a selected object.
: Opens the Edit Points toolbar if there is an object on the
Points F8 ; X ; )
slide that uses editable points, for example a freeform line.
Form Design
Tool nhame I/I{mdows macOS Effect
Linux
Position and Opens the Position and Size dialog of a
. F4 F4 i
Size selected object.
Bring to Front Ctrl + Shift + + 38 + Shift + + Moves a selected object to the front of
other objects.
Send to Back Ctrl + Shift + - S8 + Shift + - Moves a selected object to the back of
other objects.
Group Ctrl + Shift + G 8 + Shift +G Group selected objects.
Ungroup fz‘r(;l +Alt + Shift fhtﬁqrpgon * Ungroup selected group.
Enter Group F3 F3 Enter and edit a group of objects.
Exit Group Ctrl + F3 ¥ +F3 Exit a group of objects.
Image
Tool name Vl{mdows macOS Effect
Linux
Bring to Front Ctrl + Shift + + S8 + Shift + + Moves a_selected object to the front of
other objects.
Bring Forward Crl + + %8 + + Moves a sglected object in front of the
forward object.
Send Backward | Ctrl + - %8 + - Moves a sele_cted object behind the
backward object.
Send to Back Ctrl + Shift + - 38 + Shift + - Moves a selected object to the back of
other objects.
Line and Filling
Tool name I/I{mdows macOS Effect
Linux
Position and Opens the Position and Size dialog of a
. F4 F4 .
Size selected object.
Bring to Front Ctrl + Shift + + 38 + Shift + + Moves a selected object to the front of

other objects.
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Windows

Tool name ; macOS Effect
Linux
Bring Forward Ctrl + + 8 + + Moves a se_:lected object in front of the
forward object.
Send Backward | Ctrl + - 8 + - Moves a sele_cted object behind the
backward object.
Send to Back Ctrl + Shift + - S8 + Shift + - Moves a selected object to the back of
other objects.
Show the .
Styles Sidebar F11 B+T Opens the Styles deck on the Sidebar.
Outline
Tool name W' A macOS Effect
Linux
Shift + Alt + Demotes a point to the next level when
Demote . . ;
Right arrow Outline view.
= Shift + Alt + Promotes a point to the next level when
romote . . .
Left arrow in Outline view.
Shift + Alt + Shift + Option + | Moves a point down the order when in
Move Down - )
Down arrow Down arrow Outline view.
Shift + Alt + Up Shift + Option + | Moves a point up the order when in
Move Up . :
arrow Up arrow Outline view.
Slide Sorter
Tool name VI{mdows macOS Effect
Linux
glt%ré from First F5 F5 Starts a slide show from the first slide
Standard
Tool name Vl{mdows macOS Effect
Linux
New Ctrl + N ¥k +N Opens a new presentation document.
Templates Ctrl + Shift + N 3 + Shift + N Opens the Templa_ues dialog to create a
new document using a template.
Opens the Open file browser so you can
Open Ctrl + O ¥+0 navigate to a folder and select a
document.
Save Ctrl+ S #+S Saves the open document.
Opens the Save as file browser so you
Save As Ctrl + Shift + S 3 + Shift + S can save the open document as a new

document.
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Windows

Tool name : macOS Effect
Linux

Edit Mode Ctri+Shift+M | % +Shit+m | Swiches on edit mode when a
document is in read only mode.
Opens the Print dialog so that you can

Print Ctrl+ P ¥+P select how you want to print the
document.

cut Ctrl + X 58 + X Deletes t_he selected object and places it
on the clipboard.

Copy Ctrl + C % +C C_oples the selected object to the
clipboard.

Paste Cirl + V 58 +\/ Places the object on the clipboard into
the document.

Clear Dl_rect Ctrl + Shift + M S8 + Shift + M Rem_oves_dlrect fo_rmattlng that has been

Formatting applied without using styles.

Undo Ctrl+Z ¥+Z Undoes the previous editing action.

Redo Ctrl + Y 5 +Yy Reverses the action of the last Undo
command.

Find and Ctrl+ H ¥ + Option + F | Opens the Find and Replace dialog

Replace ‘

Spelling F7 F7 Starts the spelling checker.

Toggle _ Shift + E7 Shift + E7 SWltches on or off the automatic spell

Automatic Spell checking.

St_art from First F5 F5 Starts a slide show.

Slide

Start from ' ' Start; a slide show at the slide where

Current Slide Shift + F5 Shift + F5 g;e slide show was previously stopped
Switches to text edit mode and opens

Insert Text Box F2 F2 the Text Formatting toolbar.

Insert Hyperlink | Ctrl + K ¥} +K Opens the Hyperlink dialog.

Standard (Single Mode)
Tool name I/I{mdows macOS Effect
Linux

New Ctrl+ N ¥ +N Opens a new presentation document.
Opens the Open file browser so you can

Open Ctrl+ O #¥+0 navigate to a folder and select a
document.

Save Ctrl+S ¥+S Saves the open document.
Opens the Print dialog so that you can

Print Ctrl+ P ¥+P select how you want to print the

document.
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Windows

Tool name ; macOS Effect
Linux
Undo Ctrl+Z ¥} +Z Undoes the previous editing action.
Redo Ctrl+Y £ 4y Reverses the action of the last Undo
command.
Switches to text edit mode and opens
Insert Text Box F2 F2 the Text Formatting toolbar.
Position and Opens the Position and Size dialog of a
) F4 F4 i
Size selected object.
Group Ctrl + Shift + G 3 + Shift+ G Group selected objects.
Ungrou Ctrl + Alt + Shift | 3+ Option + Ungroup selected grou
group +G Shift + G group group.
Enter Group F3 F3 Enter and edit a group of objects.
Exit Group Ctrl + F3 ¥ +F3 Exit a group of objects.
glt%ré from First F5 F5 Starts a slide show from the first slide.
Start from _ _ Starts_ a slide show at th_e slide where
Current Slide Shift + F5 Shift + F5 ;r;e slide show was previously stopped
Standard (Viewing Mode)
Tool name M{mdows macOS Effect
Linux
Opens the Save as file browser so you
Save As Ctrl + Shift + S 3 + Shift+ S can save the open document as a new
document.
Edit Mode Ctrl+ Shift+M | 3 +Shift+m | SWitches on edit mode when a
document is in read only mode.
Opens the Print dialog so that you can
Print Ctrl+ P #+P select how you want to print the
document.
Copies the selected object to the
Copy Curl+C ¥+C clipboard.
Find and Ctrl+ H 3 + Option + F | Opens the Find and Replace dialog.
Replace
glt%ré from First F5 F5 Starts a slide show from the first slide.
Text
Tool name Vl{m o macOS Effect
Linux
Insert Text Box E2 E2 Switches to text edit mode and opens

the Text Formatting toolbar.

Toolbar keyboard shortcuts | 17




18 | Appendix A, Keyboard Shortcuts



	Copyright
	Contributors
	Feedback
	Publication date and software version

	Introduction
	Impress keyboard shortcuts
	Impress functions
	Slide shows
	Impress shortcuts
	Editing text

	Menu keyboard shortcuts
	File menu
	Edit Menu
	View menu
	Insert menu
	Format menu
	Slide menu
	Slide Show menu
	Tools menu
	Windows menu
	Help menu

	Toolbar keyboard shortcuts
	Drawing
	Form Design
	Image
	Line and Filling
	Outline
	Slide Sorter
	Standard
	Standard (Single Mode)
	Standard (Viewing Mode)
	Text


